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LifeWayWorship.com is an incredible online
source for worship resources. Audio and print
materials are available for every hymn in the
Baptist Hymnal plus most every contemporary
worship song being sung by churches
throughout the world. Music is purchased a la
carte—you only buy just what you need.
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Regular Price: Backing tracks are
$1.99. Listening demos are $0.99.
Sheet music is $1.49 per
instrumental part. Singer’s edition
is $0.25. Get a 30-70% discount
with a prepay plan!

Finding and Purchasing Music
To find the song you want, click on the “Find Music” tab and enter the name of the
song in the FIND MUSIC box.

Note that you can also search for songs by tempo, type of arrangement (or
supporting products), and keys.

Once you enter your search information, the site will give you a list of songs that
meet those parameters. In this example, I entered, Come, Christians, Join to Sing.
You will see that there are three different congregational arrangements of the
hymn—one in a traditional style, and two in a contemporary style.
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You may click the play button to hear samples of each song.

Once you decide which song you might wish to purchase or learn more about its
available products, click title of your selection.

You will then be taken to a screen that gives information about the song and tabs
that will take you to all the supporting products.
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The Home Page

Click here for an
audio sample

Click the key to
see additional
options (most
songs are
available in two
keys)

5
Enter the
quantity of the
item you wish to
purchase

Once you have
made all of your
selections for this
page, click, "add
to cart."

Note that each item costs less if
you take advantage of the PrePay
program
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The Audio Tab

Click "Audio" for all
associated audio
products for this
song.

1
Enter the
quantity of the
item you wish to
purchase

Once you have
made all of your
selections for this
page, click, "add
to cart."
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The Media Tab

Click the "media"
tab for the
associated
PowerPoint

Once you have
made all of your
selections for this
page, click, "add
to cart."

The Print Tab

Click the "print" tab
for the associated
print music

Enter the
quantity of the
item you wish to
purchase

1

Click on any title to preview the music
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Once you decide which parts you want, merely enter the quantity number in the
appropriate box and click, “Add to Cart,” as indicated on the previous pages.
You will then be taken to a summary screen for you to review your order:

After completing your order, merely click the checkout button and follow the
instructions to remit your payment. The products will be downloadable immediately
after your payment is approved.
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Contemporary Settings of Hymns
Note that LifeWayWorship.com has many contemporary settings of older hymns. To
look at their entire catalog of contemporary hymn arrangements, go to the SEARCH
page and just click CONTEMPORARY HYMN in the SHOW ONLY category. All the
contemporary hymn arrangements will then populate in the search results:
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SongMapTM
Once you have added a song to your shopping cart at LifeWayWorship.com, you can
create a SongMap of it. SongMap is probably the most powerful, easy-to-use tool at
LifeWayWorship.com. It puts the power of a professional arranger into the hands of
any pastor or worship pastor of any size church. Below the title is a blue box with the
words "map this song?"

When you click "Map this Song" the first thing you will see is an explanation of
SongMap. As you can see, the SongMap feature allows you to change the order of
verses, choruses, introductions, transitions and even keys for certain songs at
LifeWayWorship.com. At this point, you can choose either to continue on to the
SongMap, or you can return to the Find and Buy area. If you wish to alter the song
arrangement, click on Continue to SongMap.

In a new dialogue box, there are the basic instructions you need to map a song. Add
to your arrangement by dragging a section of the song into the "Create Your Own
Arrangement" area. Start with the basic structure by clicking "default arrangement."
To delete a slice, double click it and choose "delete selected," and press PLAY to hear
what you have done.
As you can see on the next page, I have chosen to map "I Have Decided to Follow
Jesus", the "traditional hymn" version.
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This area near the top is the "Create Your Own Arrangement" area. The first thing
you will notice here is that currently, the arrangement lasts for two minutes and nine
seconds. It currently includes all of the sections that make up the "default" version of
the song. As you can see here, "I Have Decided to Follow Jesus" has an introduction,
Verse 1, Turn 1, Verse 2, Verse 3, and Verse 4. Each one is also identified with its
key. If we click on a section, we can pick it up with the mouse and move it to a
different part of the arrangement. Just for fun, let us click on Intro and drag it to the
end.

Now you will notice that the intro is at the end of the arrangement, and all of the
other sections have moved forward. Turn 1 has moved up to fill the gap where Verse
1 used to be. Right below the arrangement, we have some additional editing
features. You can click SELECT ALL to select all of the sections. When that is done,
they all become selected and the button has been changed to DESELECT ALL. The
next button is DELETE SELECTED.
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When you double click a section, it is highlighted in yellow. Then when you click
DELETE SELECTED, it is removed from your current arrangement. The next button is
START OVER. This is sort of a "reset" button that puts all of the sections back where
they originally were. If we click SELECT ALL, DELETE SELECTED and then START
OVER, we are right back where we started!

To the right is a trash can. Instead of double-clicking on a section and choosing
DELETE SELECTED, there is a one-step method to delete a single section. Just drag it
to the trash and it is gone.
Let us not sing the fourth verse. We will just drag it to the trash.

Now, to restore that piece that we trashed, we could hit the "start over" button, or
we could look to the next area of the page, the "available sections" area. In this
area, you will see all of the sections that are available to add to your arrangement.
You can merely drag the verse 4 from the available sections area back into your
arrangement.
At the bottom of the SongMap page you have three choices:

If you choose cancel, you will lose all of the work you had done and return to the
cart. If you choose, SAVE, it will merely save your work and you will remain on this
page. If you choose, SAVE & RETURN, you will save your work and return to the
shopping cart where you can order the products you want in this newly mapped
arrangement.
SongMap is a powerful tool for making custom arrangements of songs you want to
use in worship.
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Using Audacity to Alter and Link Backing Tracks
To Create Worship Sets that Flow Smoothly

When using backing (accompaniment) tracks in .mp3 or .wav format
for leading worship(such as those purchased from LifeWayWorship.com),
one can alter the key and tempo of a song as well as create medleys (sets of music) that flow well in key
relationship and musically.

This tutorial will give step-by-step instructions for:
1) changing the key of audio files
2) changing the tempo of audio files
3) deleting sections of audio files
4) creating a medley, or set, of backing
tracks for worship

Note: in altering audio files by tempo and key, Audacity can
often introduce distortion or undesirable artifacts into a song.
When using Audacity, make as few of these alterations as
possible, and monitor to see if the final results are acceptable.
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How to Change Tempo and Pitch of Songs with Audacity
In this tutorial you will see how you can use a free audio application,
Audacity, (www.audacity/sourceforge.net) to change the tempo or pitch of
MP3 backing tracks or songs. Changing tempo helps when you would like to
sing the song in a slower or faster tempo than the original recording.
Changing pitch is useful when you need the song in a different key to work in
your song sets (NOTE: be sure the key you are changing to is
congregationally friendly).
Overview Of The Process Changing the tempo or pitch of MP3 files with
Audacity is quite simple, here are the steps:
1.Load an MP3 file and select the audio data
2.Modify the tempo
3.Modify the pitch
4.Save the result
Load an MP3 File and Select the Audio Data
1) Fire up Audacity. Import the track into Audacity (file menu > Project >
Audio Import)
2) Once the track is imported, select the entire track (file menu > Edit >
Select > All). You can also hold down the Ctrl key and press the 'A' key (Ctrl
key = command key on the Mac).
3) After making your selection, go to file menu > Effect > Change Pitch.
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Important: Effects are applied to the selected audio, so you must ensure all
the audio is selected whenever you apply an effect.
Done that? Good, now you can modify the tempo or pitch of the track. Let's
start by looking at how to modify the tempo.
Modify The Tempo
To modify the tempo of your track without altering the pitch open the Effect
menu and click “Change Tempo”
Pitfall: Don't select "Change Speed" from the menu; that effect modifies the
pitch along with the speed.
A dialogue like the one shown below appears offering controls to change the
tempo by a percentage, beats per minute or by altering the length of the
track.

I use the percentage change to alter the tempo of a track down a certain
amount. To slow things down drag the slider to the left so that a negative
value appears in the Percentage Change box, like the figure below.
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To speed up the track, you drag the slider to the right.
Click the Preview key to see if the changed tempo is the right amount. If not,
adjust up or down to meet your preference.
Important: If you wish to produce several different tracks at differing
tempos, consider this: each time you use the effect it is applied to the result
of the previous application. Slowing down in two steps of 10% each doesn't
give the same result as a single 20% slowdown to the original. I always start
from the original file, apply the tempo change I want to it, then save the
result in a new file. To create a file with a different slowed tempo I start from
the original track again so that tempos are all relative to the same point of
reference. We'll see how to save the slowed-down audio in a minute, after
we've seen how to change pitch.
Modify The Pitch
To modify the pitch of a track select the menu Effect then click “Change
Pitch.” A dialogue like the one below appears.
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You can use any of the proposed methods to change pitch. I use the Pitch
value to shift pitch up or down. Be sure to select the correct starting key of
the song, Audacity doesn't figure this out for you. Make sure that the up or
down radio buttons are properly checked to reflect if you are raising or
lowering the key.
Save The Result
Now you can modify the tempo and/or pitch of your audio tracks any way
you want. You can save the resulting audio to a new MP3 file so they are
ready to use.
Saving a new MP3 file is easy, simply open the File menu and click “Export As
MP3.” Then you can give your new track a name and save it to your media
library. Note that the original MP3 file remains intact, unaltered by the
process described here.

18

How to Combine Tracks in Audacity
In this tutorial you will see how you can use Audacity to combine two or
more tracks, creating a set of backing tracks for worship. To determine what
songs to link together that work well, refer to the Worship Leader
Handbook, pp.65-71.
Load the MP3 Files You Wish to Include
1) Fire up Audacity. Import the first track into Audacity (file menu > Project
> Audio Import)
2) Import the rest of the tracks, one at a time, into Audacity (file menu >
Project > Audio Import). The tracks will appear one above the other.

Move the Tracks to Have One Track Play After the Other One
1) Now select the left/right arrow icon:
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2) To make the tracks display in as smaller space so you can see all of the
audio files, click the magnifying glass with the “-.”

3) Click and hold on the second track and move the whole track to the right.
Move it till there is a small overlap.

Fine Tune the Connections
1) Now go back and click the normal cursor icon:

2) Then click on the tracks just before the crossfade point in the first song
before clicking play to listen to it. (The point where you click is where
playback will begin)
3) You might need to move the track a few times to get the effect you want
just right. (refer to previous section)
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Determine if a Fade Needs to Be Added
If you want the ending of the first song to fade out to shorten the bridge
between the songs, you can delete unwanted material, if any, and then fade
the ending out.
Deleting Unwanted Material
1) Select the Audio Cell
Click on the selection tool. With your mouse, select the
portion of audio that you wish to delete. Place the cursor at
the point in the waveform which marks the beginning of the
audio section you want to erase.
Click and drag the mouse to the point in the waveform which marks the end
of the audio section you want to erase. The entire section you plan to erase
should now be highlighted. To move the start or end point of the highlighted
section, hold down the "Shift" key on the computer keyboard, then use the
mouse to click on the spot in the waveform where you want the new start or
end point to be.

2) Delete the unwanted audio
section
Here you can choose to “silence”
or “delete” the portion of audio
that has been selected. (see text
box at right for the difference in
the two). For end sections like
this, I would choose, Delete.
To delete the section, just hit
your DELETE key on your
computer keyboard. The
waveform in the highlighted
section is deleted. (If you choose
SILENCE, the selection is

To Delete or to Silence
Delete does what it says–it eliminates the section of
audio you have just highlighted and pulls the
recording together at that point. Just as in word
processing if you delete a highlighted sentence it
disappears and the text below is pulled up.
“Silence” works differently. When you select Silence,
the audio that is highlighted is replaced by digital
silence but the space where the audio had been
remains the same.
In the old world of tape, Delete would be similar to
cutting out the section of tape you don’t want and
pulling the two ends together and splicing them.
Silence would be equivalent to erasing that section of
tape but leaving the blank erased tape in place.
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replaced with a straight line indicating audio silence. To select this feature,
select GENERATE from the menu bar and choose SILENCE.)
Creating a Fade
1) Select the Audio Cell
Click on the selection tool. With your mouse, select the portion of audio that
you wish to fade out by holding down the left mouse button and dragging
over the area you wish to select.

2) Create the Fade Out
Go to the top bar and click EFFECT, FADE OUT. This will fade out the audio
you have selected. You can do multiple fade outs on a selected piece of
audio. Also if you mess up or want to select a different portion just click the
Undo button.
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After Clicking FADE OUT. Your audio should look something like this, but
results may vary depending on which type of audio used and its waveform.

NOTE: You may need to continue fine tuning the connection
between songs by adjusting the starting point of the second and
subsequent tracks to achieve the bridge you desire.

Export/Saving Audio
Once you are satisfied with your editing don't forget to Save your work. In
Audacity to save a finalized a project go to FILE, EXPORT... Then simply
choose where you want to place your editing audio file. Export as an mp3 or
WAV file.
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Virtual Worship Bands

The solution to enhancing congregational worship without live instrumentalists that is least
expensive and currently best supported by print music
is the audio file backing tracks from LifeWayWorship.com
Today, four products have emerged that provide additional flexibility in live worship settings.
The cost is higher, but the interfaces and additional features make these products a great
addition to worship in churches with limited resources or in situations where no
instrumentalists are available.
We will specifically consider four options:

Worship Backing Band

www.FlyWorship.com
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Worship Band-in-Hand
Worshipbandinhand.com
Worship Band in Hand is a
mobile app for iOS (iPhone,
iPad, and iPod Touch). It
provides church and worship
leaders with a backing band that can be tailored to their needs. It’s a whole worship
band that fits in your hand!
Once you have the songs you want, all you need a 1/8th inch Y-adapter to plug your
iPhone, iPod Touch, or iPad into your sound system. All the music for Worship Band
in Hand comes out of the LEFT side of the cable. The click comes out of the RIGHT
side of the cable. You can route the click to in-ear monitors to keep the
congregation from hearing it.
Once the device is connected to your sound system, how you route the audio will
depend on your setup. One configuration would be to have the Music (Left side)
plugged into Channel 1 on your board and the Click (Right side) plugged into
Channel 2. You could turn the fader up on Channel 1 for the congregation to hear
the music. Then, you could turn your Monitor Aux Send up on both Channel 1 and
Channel 2 so that the floor/stage monitors get both the music and click track from
the App. Alternatively, you can use In-Ear monitors for the musicians to really make
sure the congregation can’t hear the click track.

Features
Custom Mix
You can mix the songs just the way you like
them. Guitars not loud enough? You can
turn them up. Loops too loud? You can turn
them down. Already have an acoustic guitar
player? Just mute the acoustic in the app
and play along.

Price: software is free. Songs vary
in price by title: single songs $9.99
or $19.99 (save with bundles). No
NC Baptist discounts available.

It’s up to you what Worship Band in Hand sounds like, and your mix is saved for
later when you use their Set List feature.
Click Tracks
Every song in Worship Band in Hand comes with a click track. So, you can play along
and stay in time with the song!
The click comes out the RIGHT Channel, and all the music comes out the LEFT
Channel. Send your device’s output to your mixing board using a “Y-Adapter”, and
you can send the click to your band’s monitors just like you would any other
instrument.
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Set Lists
You can create and edit Set Lists in the app. Add the songs you want for your next
service to a Set List. Then, during practice, you can get the mix just right. When you
press play on the Set List in your service, the app plays back everything just as you
left it. All automatically!
Key Change
You can change the key of a song
up or down a half or whole step to
better fit your voice. So, you can
use each song in 5 different keys.
When you’re using the Set List
feature, your key selection will be
saved with your mix settings.
Tempo Change
You can change the tempo of the
song to be faster or slower.
Rearrange the Song
You are no longer stuck playing a single arrangement for a song. You can now move
or remove sections of any song to fit what you need it to be.
Loop a Section on the Fly
When the song you are performing is inspiring people to worship, and you want to
repeat the section you're playing, simply press the loop button to repeat it.
No Computer Needed
You no longer need an expensive computer with an expensive audio interface and
special software to run multitracks or other backing band audio. Worship Band in
Hand runs on all current iDevices.
Support for Five Devices
Your worshipbandinhand.com account can be linked to 5 devices for playing songs
you purchase. You can sign-in to your account at any time and deactivate devices if
you need to free up an authorization.
Bluetooth Foot Pedal
You can use the foot pedal to play and pause songs, or you can loop any section
during playback.
Add-Ons
For an additional subscription fee, you can share set lists with other devices or add
your own multi-tracks and use them in the application.
Anyone Can Lead
You don’t have to own an acoustic guitar to lead worship anymore! Want to play bass
and lead worship by yourself? Let Worship Band in Hand fill in the rest of the band,
and you’re good to go.
Same thing goes for Drummers, Keyboardists, Electric Guitarists, or even just
singers. You do what you do, and let Worship Band in Hand do the rest!
AVAILABLE SONGS
Hundreds of tracks are currently available–all of which are downloaded through the
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Apple store via your WBIH app. Songs come in one key, but the app allows you to
choose one or two half steps (incrementally) above or below the key, giving you
options of five keys. Be sure to choose keys that are congregationally friendly. A
great asset is that WBIH has many LifeWayWorship tracks available. This allows you
to purchase instrumental and vocal parts from LifeWayWorship.com that coordinate
exactly with the track.
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iSingWorship
iSingWorship.com
iSingWorship will provide you with great sounding music from top
producers and musicians
in congregationallyPrice: software is free. Songs only
friendly keys. It will also
cost $2.99 each. No NC Baptist
automatically display
discounts available. The least
the lyrics accurately in
expensive of the virtual band
perfect sync (no need
options.
for PowerPoint) and, most importantly,
allow for highly flexible control of the music. You can even display the chords with
the lyrics on screen to use if you play along.
Playing
While the song is playing, you can tap on the section
of the song you would like to play next, giving you
complete flexibility in how the sections of the song will
flow. (End by going back to verse 1, repeat a chorus
with drums only, insert a quiet instrumental section
etc). If you tap on the section that is playing, it will
repeat. If you tap on a section a third time will keep it
repeating (loop). Occasionally, some sections may be grayed out if they wouldn’t
work musically following the currently playing section.
Audio Setting
iSingWorship’s audio mixer is simpler than the other
virtual bands, but it does not give you as many
options. However, in many settings, it is just what you
need. You can choose to have lead vocals assist you at
any volume level. You can choose to have
accompaniment by full band, by acoustic guitar only,
or by band without acoustic guitar (so you can play
along).
Lyrics
A great feature of this app is that it will display lyrics
to the song. You can display song lyrics on an external
screen (TV, computer screen or via a projector)
automatically in perfect sync with the music. A range
of nice background pictures or simple solid colors can
be chosen to display behind the lyrics. Wireless
support included via AirPlay mirroring with compatible
devices.
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Chords
Option to display chords (with lyrics) on your
device screen alone so they are not seen by the
congregation. A further option allows for display of
chords on the external screen for band rehearsals.
Key Change
Each song can be played back in a choice of 7
keys. This ensures the vocal ranges will be
comfortable for congregations, men’s groups,
women’s groups or your own personal worship times. Be sure to choose
congregationally friendly keys for your songs.
Playlists
Prepare your set list of songs in advance – you can
have each song play continuously one into the next
or insert pauses between any or all of them.
Congregationally Friendly Arrangements
Musical, natural and fresh sounding arrangements
performed and recorded by some of the nation’s
top musicians and producers in congregational
friendly keys (alternative keys also possible).
Growing library of songs
The song library contains some of the the most popular worship songs with many
more currently in production. Songs can be purchased from the built-in song store
using your iTunes account details.
Fully licensed congregational versions of songs (includes all instrumental and vocal
parts, lyrics, guitar chords and complete flexibility) for $2.99.
Any purchased song may be downloaded again free of charge onto different devices
owned by the same person using their iTunes account details.
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Worship Backing Band
MultiTrack Player
a product of www.Musicademy.com
WorshipBackingBand.com
Worship Backing Band MultiTrack Player is a simple and great value solution for
churches that want to play modern worship songs but don’t have a full band. The
application is an extremely simple to use Mac & PC downloadable software player
with Musicademy’s custom backing tracks that let you choose any combination of
instruments to appear in the mix.
So if your band only
has a keyboard and
guitar you can mute
those instruments on
the backing track and
leave in the drums,
bass, electric guitars
etc. and play along.
You can even leave in
the lead vocals if you
like or adjust the
volume of any instrument to suit your worship team’s makeup. Coming soon is a
feature which will enable you to repeat sections of the song. There will be a deal for
existing customers who wish to additionally purchase the new player.
The player is very easy to use. In fact it’s designed for people who aren’t technically
minded and want to get on with playing music, not learning software. So don’t worry
if you’re not familiar with Pro Tools,
Ableton, Garageband etc, this player is WAY
Price: $49.99 for the browsersimpler to use than all of those. If you’re
based software. Tracks are $17.00
comfortable with the usual play, stop,
each. Quantity discounts are
volume & mute type functions on any
available to $10.00 per song. NC
standard remote control you’ll be right at
Baptist discount is also available.
home.
There are some really useful features; like the ability to change the song’s key
and/or tempo, selectable click tracks and vocal cues to remind you of key lyrics
and song structure, an intro count and two separate mixes. One for the congregation
and a fold back mix for the band, each allowing you to choose any combination of
instruments. Perfect if you want to use the click tracks & vocal cues just for the
band, or even mute the lead vocal out front but keep a little in the foldback to help
you sing confidently.
You don't need any special hardware or additional software to run it. Simply
download the song you want from the Worship Backing Band website, drag it into
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your play list, mix/mute the instruments already in your band and hit play.
The backing tracks themselves are professionally recorded by some of the best
Christian session musicians around, in church friendly keys and arrangements, “all
played and sung worshipfully with real meaning and emotion.”
Plus there are some really useful features; like selectable click tracks and vocal cues
to remind you of key lyrics and song structure, an intro count and two separate
mixes-- one for the congregation and a fold back mix for the band, each allowing you
to choose any combination of instruments. Perfect if you want to use the click tracks
& vocal cues just for the band, or even mute the lead vocal out front but keep a little
in the foldback to help you sing confidently.
It can be operated by your worship leader, a musician or even the sound engineer,
and the best thing is you don’t need any special hardware or additional software to
run it. Simply download the player and some songs to your Mac or PC, plug a cable
into the headphone socket and you’re ready to go!

Advanced Features
•
•
•
•
•

Loop, repeat or jump to any song section
Key/tempo change
Footswitch and hot key control
High definition audio (14 stems including
voices)
Import your own song wav files

This multitrack solution gives you all the key
functionality of DAWs like Ableton but in a far simpler
interface. Full song navigation control, key and tempo
change, fully controllable via footswitch and hotkeys,
high definition audio with 14 stems including vocals
and BVs. You can even import your own song WAVs.
The Player is great for learning band parts too. You
can Solo any stem to easily hear the exact instrument
part; loop the part over and over to practice and even
slow complicated sections right down until you get
the hang of it.
The MultiTrack Player Stems Explained
Here is a detailed description of the format of the
stems (individual instruments) used on the MultiTrack Player. Each stem is discussed
below, but it’s also worth pointing out that each stem has a separate volume fader
for the left and right hand sides of its sound. This for one very important reason. If
you use a standard splitter cable out of your computer’s headphone socket it allows
you to put the left and right sides into two channels in your church’s mixing desk.
Then you can feed one channel to the congregation, known as a ‘Front of House’ mix
and use the other side as a foldback (monitor) mix to your band. If you’re brand new
to this, the band basically need to hear different instrument levels than the
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congregation, with some stems boosted and others cut out all together in order to
follow the music leader and the song.
Two-Bar Click Intro This two-bar intro click is standard on every song and helps
everyone come in on cue. If you don’t want the congregation to hear the click then just
put it in your foldback mix and mute the other side (see below for explanation)
Lead Vocals Even if you have a lead vocalist, this is useful on many levels. Set them low
to ‘fatten up’ your own vocal or to set them high to give you extra confidence and sing
along. (Not all competitor’s backing tracks have lead vocals and it’s pretty difficult for
some people to follow a backing track if there’s absolutely no vocal cue at all).
BV’s – Backing Vocals
These are great as a training tool too. Solo them (this mutes everything else) to hear the
harmonies and then add your own harmonies for wide lush BV’s
Acoustic Guitars Most songs have acoustic guitar, where they didn’t include one they
thought one was not needed.
Electric Guitars 1 There are two distinct guitar parts in each song. One could be textural
and the other a lead line, or two rhythm parts playing in the same place. Again try
soloing the parts in practice to learn some great guitar lines for you to play live or set it
low in the mix and find your own voicings to compliment what’s already there
Electric Guitars 2 As above
Keyboards 1 Keys 1 and 2 could be any combo of piano, synth, pads, Hammond organ
etc. They just chose the most appropriate combinations for the song.
Keyboards 2 As above
Bass These are session standard bass guitar parts. Switch them on or off or learn the
parts yourself to play along live
Drums The whole drum kit, in one stem.
Extras Vary from song to song but are other elements designed to give width and
texture to the recordings that are not easily grouped into the standard stem format. So
programming, percussion, loops brass, extra guitars, strings pads etc.
Click Track Again, set this just in your foldback mix (if you don’t want the congregation
to hear it) and it will help keep the whole band in time, not just the drummer!
Natural click Use the shaker loop to keep in time if you want a more ‘natural’ click
sound (or aren’t using separate congregation and foldback mixes)
Vocal cue This spoken word vocal cue just reminds you of difficult to remember lyrics or
song structure points, e.g “intro starts with guitar riff….2 3 4” or “repeat chorus…blessed
be the name of" or “all instruments pause for soft chorus …2 3 4”
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Fly Worship
FlyWorship.com
Fly is designed to help facilitate worship in
small churches or other settings where
there is a shortage of musicians.
Technically, it is a software application
combined with audio tracks, controlled by
a footpedal. The “on the fly” features are
what makes Fly so incredible for worship:
Special Features
Looping. When you lead worship, often you want to flow where you feel led. With a
normal band you can repeat sections easily. Fly gives you that same ability. If you
want to do another chorus, bridge or intro just hit the pedal and around you go
seamlessly. So natural and so simple.
Fading. Another dynamic effect we use
naturally in the context of a normal band is
volume changes or dynamics. Fly allows you
to program exactly which instruments will
fade out (and to what degree) and how fast
the fade will occur. During worship, you can
tap the appropriate pedal, and the
instruments will fade as previously
determined. When you tap the pedal again,
the levels resume.

Price: Several options: see chart
on next page. Songs are $10 each.
LifeWayWorship songs are
available. Get $100 discount and 5
free songs with voucher code:
KLWAY
Contact Kenny Lamm for four pedal
options with discounts.

Custom Mixes. Depending on the situation and perhaps your own musical taste,
you can apply different audio mixes within Fly. There are three presets, Full band,
Mellow and Acoustic. The levels have been set to suit those situations, although they
can be changed easily. There is even a custom mix you can use to create your own
sound.
Link Tracks. To provide seamless worship, Fly allows you to select a keyboard pad
in any key to join your songs together.
Additional Considerations
Ø

Fly utilizes stem mixes with this instrumentation:
o Acoustic guitar
o Bass
o Drums
o Electric Guitar
o Keyboard
o Percussion
o Piano

Ø

There are no vocal parts in the mix
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New Audio Enhancements
• Custom arrangements, Make your own versions of songs!
• Import: import your own recordings or audio from other providers.
• Key Change: Change the key to lift songs at just the right moment.
• Tap Tempo: Too fast or slow? Tap in a new tempo on demand. This allows
you to speed up or slow down a song live.
• Navigation keys to jump to: "V" (verse), "C" (chorus), "B" (bridge), "E"
(end).
• Link tracks for seamless track to track navigation.
• Superb audio repositioning accuracy
• Start song on Fade (As if the Dynamics pedal has been pressed).
• Import Facility. Use your own audio files with all of Fly's standard facilities.
• Quick Map builder for imported tracks.
• Optimized playback engine for seamless looping.
New Projection Enhancements
•
•
•
•

•

Video background playing on the external lyric projection.
Visual plugins for backgrounds (Audio sensitive animations)
Easy external display detection.
Separately maintained lyrics. The text shown on the projector can be
different than in main window. This allows the use of chord symbols on
the laptop screen
Customizable logo shown on the bottom right corner of the external
display.

Additional Enhancements
•
•
•
•
•
•

USB dongle mode, allows you to install Fly on more than one computer
using a USB flash drive (*optional).
New SYNC function to synchronize your songs/arrangements, in fact
everything between computers!
New graphic interface, based on Skin theme to customize the whole
appearance of Fly (with carousel selector).
Visual level meters per track.
Internal code optimization to keep the CPU footprint as low as possible.
Compatibility with Windows VISTA/SEVEN to use full transparency in
AERO mode (with lyric projection).

Three Versions
See the table on the next page for the differences in Fly Free, Fly Standard, and Fly
Pro.
Fly Pro for Ultimate Audio Control (package - $849). Fly Pro is intended for users
who would like the ability to mix the instruments individually on the Mixing Board.
Each instrument track is routed separately to the Mixer via a dedicated audio
interface. This means each instrument can change the levels, equalization,
compression etc. in the same way as you would a live band.
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